ACS450®

PC Software for Burner Management System
LMV5...

Operating Instructions
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>1.1</td>
<td>Overview</td>
<td>5</td>
</tr>
<tr>
<td>1.2</td>
<td>Scope of delivery</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>Typographical conventions</td>
<td>6</td>
</tr>
<tr>
<td>2.1</td>
<td>Safety guidelines</td>
<td>6</td>
</tr>
<tr>
<td>2.2</td>
<td>Special note</td>
<td>7</td>
</tr>
<tr>
<td>2.3</td>
<td>Correct system parameter settings</td>
<td>7</td>
</tr>
<tr>
<td>2.4</td>
<td>Setting the electronic fuel/air ratio control system</td>
<td>7</td>
</tr>
<tr>
<td>2.5</td>
<td>Changing the parameters and the plant configuration</td>
<td>7</td>
</tr>
<tr>
<td>2.6</td>
<td>Shutdown function of the LMV5 basic unit via the ACS450</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>END USER LICENSE AGREEMENT</td>
<td>9</td>
</tr>
<tr>
<td>4</td>
<td>System specification</td>
<td>13</td>
</tr>
<tr>
<td>5</td>
<td>Handling and storage</td>
<td>14</td>
</tr>
<tr>
<td>5.1</td>
<td>Notes on handling the CD</td>
<td>14</td>
</tr>
<tr>
<td>6</td>
<td>Languages</td>
<td>14</td>
</tr>
<tr>
<td>7</td>
<td>Installation</td>
<td>15</td>
</tr>
<tr>
<td>7.1</td>
<td>Installing the hardware</td>
<td>15</td>
</tr>
<tr>
<td>7.2</td>
<td>Installing the software</td>
<td>16</td>
</tr>
<tr>
<td>7.2.1</td>
<td>Settings under Windows</td>
<td>16</td>
</tr>
<tr>
<td>7.2.2</td>
<td>Installing the ACS450</td>
<td>16</td>
</tr>
<tr>
<td>7.2.3</td>
<td>Deinstalling/repairing</td>
<td>17</td>
</tr>
<tr>
<td>7.2.4</td>
<td>Disposal</td>
<td>18</td>
</tr>
<tr>
<td>7.3</td>
<td>Files included in the scope of delivery</td>
<td>19</td>
</tr>
<tr>
<td>7.4</td>
<td>Generated files</td>
<td>20</td>
</tr>
<tr>
<td>8</td>
<td>General note!</td>
<td>21</td>
</tr>
<tr>
<td>9</td>
<td>Installation of ACS450</td>
<td>22</td>
</tr>
<tr>
<td>10</td>
<td>The first steps</td>
<td>27</td>
</tr>
<tr>
<td>10.1</td>
<td>Program registration</td>
<td>27</td>
</tr>
<tr>
<td>10.2</td>
<td>Operation of the ACS450 in connection with the LMV5 system</td>
<td>28</td>
</tr>
<tr>
<td>10.3</td>
<td>Closing the program</td>
<td>29</td>
</tr>
<tr>
<td>10.4</td>
<td>ACS450 in offline mode</td>
<td>29</td>
</tr>
<tr>
<td>11</td>
<td>General operating functions</td>
<td>30</td>
</tr>
</tbody>
</table>
11.1 Scope of functions ......................................................................................... 30
11.2 Title bar .......................................................................................................... 30
11.3 Operating mode ............................................................................................. 30
11.3.1 Operation of the ACS450 on the plant ........................................................... 30
11.4 Password ....................................................................................................... 31
11.4.1 Overview ........................................................................................................ 31
11.4.2 Entering the password ................................................................................... 31
11.4.3 Changing and leaving the password level ..................................................... 32
11.5 Normal operation ........................................................................................... 33
11.6 Fault status .................................................................................................... 34
11.7 Parameter settings and configuration ............................................................ 35
11.7.1 Introduction .................................................................................................... 35
11.7.2 Procedure ...................................................................................................... 35
11.8 Backup/restoring the data sets ...................................................................... 39
11.8.1 Backup the AZL5 ........................................................................................... 39
11.8.2 Restore .......................................................................................................... 40
11.8.3 Backup/Restore via PC ................................................................................. 40
11.9 Resetting/initializing the basic unit ................................................................. 43
11.9.1 Resetting the basic unit ................................................................................. 43
11.9.2 Initializing the basic unit ................................................................................. 44
11.10 Switch-off function (manual locking of the basic unit LMV5) ......................... 44
11.11 Adjusting the fuel/air ratio control system ...................................................... 45
11.11.1 Modulating operation ..................................................................................... 45
11.11.2 Multistage operation ..................................................................................... 52
11.12 O2 setting ...................................................................................................... 53
11.12.1 Setting the O2 min values ............................................................................. 53
11.12.2 Setting the O2 ratio values ............................................................................ 54
11.12.3 Leaving the O2 setting ................................................................................... 54
11.12.4 Tabular display .............................................................................................. 54
11.12.5 Printing .......................................................................................................... 55
11.13 Fault history and lockout history .................................................................... 55
11.13.1 Fault history ................................................................................................... 55
11.13.2 Lockout history ............................................................................................ 55
11.14 Time of day and date ..................................................................................... 55
11.15 Trending/write function .................................................................................. 56
11.15.1 Overview....................................................................................................... 56
11.15.2 Calling up the trending function ................................................................. 56
11.15.3 The trending window ................................................................................... 57
11.15.4 Display of a channel ..................................................................................... 57
11.15.5 Display settings ............................................................................................. 58
11.15.6 Printing .......................................................................................................... 58
11.15.7 Setting the interval ....................................................................................... 58
11.15.8 Triggering....................................................................................................... 59
11.15.9 Status display................................................................................................. 59
11.15.10 Full screen .................................................................................................. 60
11.15.11 Name of measurement ............................................................................. 60
11.16 Program update AZL5.................................................................................... 61
11.16.1 Introduction................................................................................................... 61
11.16.2 Preparing the AZL5.................................................................................... 61
11.16.3 Preparing the ACS450................................................................................. 61
11.16.4 Programming process.................................................................................. 61
11.16.5 End of the programming process - check .................................................. 62

12 Offline mode....................................................................................................... 63
12.1 Overview............................................................................................................ 63
12.2 Preparation for the display of parameters..................................................... 63
12.3 Calling up the parameter display .................................................................... 64
12.4 Control file for displaying and printing parameters...................................... 65
12.4.1 Main section of file ..................................................................................... 65
12.4.2 Print section ................................................................................................ 66
12.5 Trending/show write function......................................................................... 68
12.5.1 Overview...................................................................................................... 68
12.5.2 Selecting the database................................................................................ 68
12.5.3 Main dialog Trending.................................................................................. 69

13 Online help.......................................................................................................... 70

14 Fault handling.................................................................................................... 70
14.1 Faults during the parameter setting procedure.............................................. 70
14.2 Faults when opening a connection................................................................. 70
1 Introduction

1.1 Overview

The ACS450 is a PC-based operating program for use with the LMV5 burner management system. The requirements placed on the relevant PC are specified in chapter System specification. The PC must be connected directly to the AZL5 display and operating unit via a serial port.

The ACS450 operating software provides the following key functions:
- Readout of settings, operating states and kinds of faults of the LMV5 system as well as the time of day the faults occurred
- Graphic support when setting the electronic fuel/air ratio control system
- Setting the parameters of the LMV5 system
- Trend recording (write function)
- Printout functions for documenting the plant settings
- Program update AZL5

All key data can be filed in databases and viewed later without necessarily having to use the LMV5 system.

The different parameter setting levels for the burner/boiler manufacturer and the heating engineer are password-protected to prevent unauthorized access. The basic settings that can be made on site by the plant operator do not require a password.

Operation of the program is mainly based on Windows standards and demands basic PC knowledge. If desired, Windows' online help system can be used. It can be retrieved via the standard menu.

1.2 Scope of delivery

The operating software is supplied on a CD. In case of loss, a replacement CD can be ordered under type reference ACS450.

The connecting cable for linking the AZL5 display and operating unit to the PC is not included in the delivery. The required cable is specified in section Installing the hardware.

The CD contains the following files:
- Setup_EN.exe
- ACS450.msi
- Setup.ini
- Data1.cab
- 0x0407.ini
2 Typographical conventions

2.1 Safety guidelines

This manual contains notes which you should observe to ensure your own personal safety and to protect the product and connected equipment. These notes are highlighted in the manual by a warning triangle, arrow or hand and are marked as follows according to the level of danger:

![Danger](image) **Danger** indicates that death, severe personal injury or substantial property damage will result if proper precautions are not taken.

![Warning](image) **Warning** indicates that death, severe personal injury or substantial property damage can result if proper precautions are not taken.

![Caution](image) **Caution** indicates that minor personal injury or property damage can result if proper precautions are not taken.

![Note](image) **Note** draws your attention to particularly important information on the product, product handling, or to a particular part of the documentation.

![Reference](image) **Reference** makes reference to additional information given in other pieces of user documentation, chapters or sections.

**Qualified staff**

Only **qualified staff** should be allowed to install and work on the equipment. Qualified staffs are defined as persons who are authorized to commission, ground, and tag circuits, equipment and systems in accordance with established safety practices and standards.

**Correct usage**

*Note the following:*

This device and its components may only be used for the applications described in the technical documentation, and only in connection with devices or components from other manufacturers that have been approved or recommended by Siemens AG Building Technologies.

This device can only function correctly and safely if it is shipped, stored, set up, and installed correctly, and operated and maintained as recommended.
2.2 Special note

**Warning!**
The ACS450 operating software is a convenient tool for qualified staff designed to commission and optimizes combustion plant equipped with the LMV5 system. Since the settings and interventions to be made are safety-related, the user must exercise special care. Although technical precautionary measures have been taken aimed at avoiding wrong data entries and incorrect parameter values, the user is required to check the safe functioning of the plant in a conventional manner both during and after commissioning and to shut it down manually, should this be required.

2.3 Correct system parameter settings

**Warning**
With the LMV5 system, it should be considered that the device characteristics are determined primarily by the parameter settings and not so much by the type of unit. In particular, the OEM is responsible for the correct parameter settings conforming to the standards covering the application. The individual responsible for the parameter settings is the person who, according to the access rights to the relevant setting level, makes or has made changes. The detailed descriptions and safety notes given in the Basic Documentation of the associated system components must also be observed.

2.4 Setting the electronic fuel/air ratio control system

**Warning**
When setting the electronic fuel/air ratio control system, the user must make checks with a flue gas analyzer. If necessary, the plant must be shut down manually. This applies to both operating modes, modulating and multistage. In addition, the set plant must be run through the entire sequence with an AZL5 in normal operating mode without using the ACS450 to ensure that the settings are correct.

2.5 Changing the parameters and the plant configuration

**Warning**
The procedure for checking *Required and Actual* as described in chapter 12 must be strictly observed. Here, the program offers help by providing additional dialogs that appear on the screen. If there are departures from the required values, the notes given in chapter 12 must be observed. In addition, it is mandatory to verify the correct parameter settings with an AZL5 without using the ACS450.
2.6 Shutdown function of the LMV5 basic unit via the ACS450

**Danger!**
For shutdown in the event of fault, direct-acting facilities (open main switch of the safety loop) should be used, since the plant does not initiate lockout when activating this shutdown function via the ACS450 when, for example, due to a communication breakdown between PC and AZL5, the function can no longer be performed.

**Note!**
The shutdown function on the AZL5, initiated by pressing simultaneously the 2 buttons Enter and Esc, is also maintained in interface mode.
3 END USER LICENSE AGREEMENT

IMPORTANT!
READ CAREFULLY.

This End-User License Agreement ("EULA") is between You (either an individual, a legal entity or any affiliated companies or other entities) and Switzerland Ltd., ("Siemens"). The EULA authorizes You to use the Licensed Software, specified in Clause 1 below, under the terms and conditions set forth below. Read this EULA carefully before installing or using the Licensed Software. By installing, copying, and/or using the Licensed Software, You acknowledge that You: (1) have read and understood the EULA as well as each of the third party licenses, Open Source Software licenses and additional terms set forth in the ReadMe file, containing the Additional Terms Addendum below ("Additional Terms"). (2) agree to be bound by all of the terms and conditions for this EULA and such Additional Terms. You further agree that if Siemens or any licensor of Siemens is required to engage in any proceeding, legal or otherwise, to enforce their rights under this EULA, Siemens and/or its licensor shall be entitled to recover from You, in addition to any other sums due, reasonable attorney’s fees, costs and disbursements. If You do not agree to all of the terms and conditions of this EULA, Siemens is unwilling to license the Licensed Software to you. In such an event, you should not install the Licensed Software and promptly contact Siemens for instructions on return of the Licensed Software.

This EULA governs any Updates, releases, revisions, or enhancements to the Licensed Software.

1. LICENSED SOFTWARE.
   As used in this EULA, the term "Licensed Software" means (i) the software offered by Siemens under the brand "ACS450" in any release and (ii) any related electronic or written documentation for the Licensed Software.

2. INTELLECTUAL PROPERTY RIGHTS NOTICE.
   The Licensed Software and all rights, without limitation including proprietary rights therein, are owned by Siemens, their licensors or affiliates and are protected by international treaty provisions and all applicable national laws. The structure, organization, and code of the Licensed Software are the valuable trade secrets and confidential information of Siemens, their licensors or affiliates. Except as expressly and unambiguously provided herein, You do not possess, and Siemens does not grant to You, any express or implied rights (whether by implication, estoppels or other legal theory) in or to any such intellectual property rights and all such rights are retained by Siemens, its licensors or affiliates. You must reproduce and include the copyright notices with any permitted copies You make of the Licensed Software.

3. LICENSE Grant AND USE RESTRICTIONS.
   The Licensed Software is not sold to You. Siemens only grants to You a non-exclusive, non-transferable license to use the Licensed Software in object code solely for your own use. The EULA permits use of the Licensed Software, only within the boundaries established herein that may be supplemented by the order confirmation. The configuration and execution of the Licensed Software may be supervised by a license key and/or set, during installation. Any component of the Licensed software shall be used exclusively for the "ACS450" application.
4. LIMITATIONS ON LICENSE.
You may not copy, distribute, or make derivative works of the Licensed Software except as follows:
(a) You may make one copy of the Licensed Software, excluding the documentation, as an archival backup copy of the original. Any other copies You make of the Licensed Software are in violation of this EULA.
(b) You may not use, modify, or transfer the right to use the Licensed Software other than together with the accompanying hardware or copy the Licensed Software except as expressly provided in this EULA.
(c) You may not sublicense, rent or lease the Licensed Software.
(d) You may not or direct any third party to reverse engineer, de-compile, or disassemble those Licensed Software programs except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.
(e) This EULA does not grant You any rights whatsoever in relation to the trademarks or service marks of Siemens, Siemens AG or either’s affiliates.
(f) Parts of the Licensed Software may be supplied by third parties and may be subject to separate license terms such as those set forth within the ReadMe file as Additional Terms below. In the event that you receive the terms and conditions stipulated by the relevant third party licensor together with the Licensed Software, such terms and conditions shall apply with respect to the third party licensor’s liability towards you. Siemens own liability to you is governed by this EULA.
(g) The Licensed Software may contain Open Source Software (hereinafter referred to as “OSS”) that is listed within the ReadMe file as Additional Terms below. As set forth in these Additional Terms, You are entitled to use the OSS in accordance with the respective license conditions of the OSS. The license conditions of the respective OSS shall prevail over this EULA with respect to the OSS. If the license conditions of the OSS require the distribution of the source code of such OSS, Siemens shall provide such source code upon request against payment of the shipping and handling charges.

5. MISUSE OF THE LICENSED SOFTWARE OR DATA GENERATED BY THE LICENSED SOFTWARE IS STRICTLY PROHIBITED BY LICENSOR, MAY VIOLATE SWISS, U.S. AND OTHER LAWS AND MAY SUBJECT YOU TO SUBSTANTIAL LIABILITY.
You are solely responsible for any misuse of the Licensed Software under this EULA and for any liability or damage related in any way to your use of the Licensed Software in violation of this EULA. You are also responsible for using the Licensed Software in accordance with the limitations of this EULA.

6. TERMINATION.
This EULA is effective from the first date You install, copy or otherwise use the Licensed Software. You may terminate this license at any time by deleting or destroying the Licensed Software, all backup copies and all related materials provided to You by Siemens. Your license rights terminate automatically and immediately without notice if You fail to comply with any provision of this EULA.
7. WARRANTY DISCLAIMER.
YOU ACKNOWLEDGE THE LICENSED SOFTWARE IS PROVIDED "AS IS" AND NEITHER SIEMENS NOR ANY OF THEIR LICENSORS MAKE ANY REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR THAT THE LICENSED SOFTWARE WILL NOT INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS. THERE IS NO WARRANTY BY SIEMENS OR THEIR LICENSORS OR BY ANY OTHER PARTY THAT THE FUNCTIONS CONTAINED IN THE LICENSED SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY A SIEMENS REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY AFFECT THIS DISCLAIMER. YOU_ASSUME ALL RESPONSIBILITY TO ACHIEVE YOUR INTENDED RESULTS AND FOR THE INSTALLATION, USE, AND RESULTS OBTAINED FROM IT.

8. NO OTHER OBLIGATIONS; RESERVATION OF RIGHTS.
This EULA creates no obligations on the part of Siemens other than as specifically set forth herein. Siemens reserves all rights not expressly granted to You in this EULA.

9. LIMITATION OF LIABILITY.
IN NO EVENT SHALL SIEMENS, ITS EMPLOYEES, LICENSORS, AFFILIATES OR AGENTS BE LIABLE FOR ANY LOST PROFITS OR COSTS OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, PROPERTY DAMAGE, LOSS OF PROFITS, INTERRUPTION OF BUSINESS OR FOR ANY SPECIAL, INDIRECT, INCIDENTAL, ECONOMIC, PUNITIVE OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED, AND WHETHER ARISING UNDER CONTRACT, TORT, NEGLIGENCE, OR OTHER THEORY OF LIABILITY, OR ARISING OUT OF THE USE OF OR INABILITY TO USE THE LICENSED SOFTWARE, EVEN IF SIEMENS IS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE LIMITATION OF LIABILITY SHALL NOT APPLY IF AND TO THE EXTENT SIEMENS'S LIABILITY IS MANDATORY UNDER THE APPLICABLE LAW E.G. PRODUCT LIABILITY LAW OR INTENTIONAL MISCONDUCT.

10. TECHNICAL SUPPORT AND AUDIT.
Siemens and its affiliates have no obligation to furnish You with technical support unless separately agreed in writing between You and Siemens. Siemens and where applicable their licensors in the Licensed Software shall be free to use any feedback and/or technical data including audit data received from You resulting from your access to and use of the Licensed Software for any purpose including (without limitation) the manufacture, marketing and maintenance or support of products and services. If and insofar as permissible under the relevant laws You permit Siemens and its affiliates to audit the use of the Licensed Software and will give assistance and access to the necessary information.

11. EXPORT CONTROL.
The Software, including technical data / cryptographic software, may be subject to Swiss, German, European Union and U.S. export controls and may be subject to import or export controls in other countries. You agree to strictly comply with all applicable import and export regulations. Specifically, You agree, to the extent required by U.S. Export Administration Regulations, that You shall not disclose or otherwise export or re-export the Licensed Software or any part thereof delivered under this EULA to any country (including a national or resident of such country) to which the U.S. has restricted or prohibited the export of goods or services. You represent and warrant that You are not (i) located in any country that is subject to a U.S. Government embargo, or that has been designated by the U.S. Government as a "terrorist sponsoring" country, or (ii) listed on any U.S. Government list of prohibited or restricted parties including the Treasury Department's list of Specially Designated Nationals or the U.S. Department of Commerce Denied Person's List or Entity List.
12. FOR U.S. GOVERNMENT END USERS.
The Licensed Software was developed at private expense and each component thereof is a “commercial item” as that term is defined at 48 C.F.R. 2.101, consisting of “commercial computer software” and “commercial computer software documentation” as such terms are used in 48 C.F.R. 12.212 and FAR 52.227-19 Commercial Computer Software License. The Uniform Computer Information Transactions Act is excluded. Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government end users acquire the Licensed Software with only those limited rights set forth therein. Publisher is Siemens Switzerland, Ltd., Gubelstrasse 22, 6301, Zug, Switzerland.

13. APPLICABLE LAW AND FORUM.
This EULA is governed by the laws of Switzerland. No choice of law rules of any jurisdiction will apply. Any disputes arising out of or relating to this EULA shall be settled by the courts in Zürich to the extent permitted by mandatory law.

14. MISCELLANEOUS.
Unless Siemens has given separate individual contract conditions in writing this EULA represents the entire agreement between You and Siemens relating to the Licensed Software and (i) supersedes all prior or contemporaneous oral or written communications, proposals, and representations with respect to its subject matter; and (ii) prevails over any conflicting or additional terms of any acknowledgement or similar communication between the parties during the term of this License. Notwithstanding the foregoing, some products of Siemens may require You to agree to additional terms through an on-line “click-wrap” license, and such terms shall supplement this EULA. If any provision of this EULA is held invalid, all other provisions shall remain valid unless such validity would frustrate the purpose of this EULA, and this EULA shall be enforced to the full extent allowable under applicable law. No modification to this EULA is binding, unless in writing and signed by a duly authorized representative of each party. This EULA shall be binding on and shall inure to the benefit of the heirs, successors, and assigns of the parties hereto. The failure of either party to enforce any right resulting from the breach of any provision of this EULA by the other party will not be deemed a waiver of any right related to a subsequent breach of such provision or any other right hereunder.

© Siemens Switzerland Ltd. 2015. All rights reserved.

Caution!

SPECIAL NOTE
In cases where the SOFTWARE can be or is used for setting the parameters of combustion plants, both the licensee and all users assume a special responsibility. After setting the parameters, both the licensee and the user undertake to check the safe function of the plants and to ensure manual shutdown if required. The licensee, the OEM, or the user who made the settings will always take full responsibility for the parameters, their settings and compliance with the relevant national and international standards and safety regulations. The safety notes in the relevant documentation must be strictly complied with. Siemens, its suppliers and other Group Companies of Siemens AG do not assume responsibility for special or indirect damage, consequential damage, other damage, or damage resulting from wrong parameterization.
4 System specification

- HDD: Min. 10 MB free hard disk storage. Additional storage capacity is required for recording write data
- COM: Free serial communication interface RS-232
- Operation: Mouse or touchpad
- CD: CD-ROM drive for program installation

When using part functions, the ACS450 requires extensive processing capacity of the PC, for example for recording write data. It is therefore recommended to keep the number of active additional applications (tasks) as low as possible.

Operation of the LMV5 burner control via ACS450 software calls for the following equipment combinations:

<table>
<thead>
<tr>
<th>Display and operating unit AZL5</th>
<th>Burner control LMV5</th>
</tr>
</thead>
<tbody>
<tr>
<td>AZL52 V03.20 or higher</td>
<td>LMV51 V01.70 up to V03.00</td>
</tr>
<tr>
<td></td>
<td>LMV52 V01.00 or higher</td>
</tr>
<tr>
<td></td>
<td>Without backup/restore function via PC</td>
</tr>
<tr>
<td>AZL52 V03.40 or higher</td>
<td>LMV51 V01.70 up to V03.00</td>
</tr>
<tr>
<td></td>
<td>LMV52 V01.00 or higher</td>
</tr>
<tr>
<td></td>
<td>With backup/restore function via PC</td>
</tr>
</tbody>
</table>

Operating system:
- Windows (r) Windows 7
- Windows (r) Windows 8.1
- Windows ® Windows 10 (release 1803)

The system requirements are determined mainly by the choice of Microsoft operating system used!

Example: Minimum hardware requirements!

<table>
<thead>
<tr>
<th>System</th>
<th>32 bit</th>
<th>64 bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz (x86) or higher (Win8, with support for PAE, NX and SSE2)</td>
<td>1 GHz (x64) or higher (Win8, with support for PAE, NX and SSE2)</td>
</tr>
<tr>
<td>Main memory (RAM)</td>
<td>1 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Hard disk memory</td>
<td>16 GB</td>
<td>20 GB</td>
</tr>
<tr>
<td>Graphics card</td>
<td>DirectX 9 graphics card with WDDM driver</td>
<td></td>
</tr>
<tr>
<td>Screen resolution</td>
<td>Minimum screen resolution 1024 x 786.</td>
<td></td>
</tr>
</tbody>
</table>

Different, higher requirements may apply due to the choice of operating system or hardware used.
More detailed information is available at www.microsoft.com.
5 Handling and storage

5.1 Notes on handling the CD

Note!
- Do not expose the CD to direct solar radiation or other UVA/UVB radiation
- Avoid excessive temperatures, humidity, dust, vibrations, dirt, scratches, etc.
- Clean the CD only with suitable cleansing agents and use a dry, soft and fluff-free cloth
- If not in use, keep the CD in the plastic box

6 Languages

The ACS450 is available in German and English.
7 Installation

7.1 Installing the hardware

Note!
All screenshots were taken on the OEM level!

The connection between PC and AZL5 is made via a serial RS-232 port.

For connecting the AZL5, the connecting cable requires a SUB-D connector with 9 pins and, usually, a SUB-D connector with 9 pins for the PC. For detailed information, refer to the documentation supplied with your PC.

The connection between the RxD and TxD signals must be crossed.

<table>
<thead>
<tr>
<th>Connecting cable</th>
<th>9-pin connector</th>
<th>Cable</th>
<th>9-pin connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxD</td>
<td>RxD</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>TxD</td>
<td>TxD</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>GND</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

In place of the standard connecting cable, it is also possible to use a combination of standard data communication components such as a SUB-D data cable with 9 pins, m/f 1:1, and a SUB-D mini adapter null modem with 9 pins, m/f.

Screwed locks for the connectors
We recommend using the existing screwed locks for the RS-232 port in order to avoid malfunctions resulting from loose connectors. The ACS450 sets the transmission parameters 19,200 Bit/s, 8 data bits, no parity and 1 stop bit automatically.
7.2 Installing the software

7.2.1 Settings under Windows

To ensure reliable operation, the System standby and Non-operated functions must be deactivated under Windows7 and Windows8.1. These options can be deactivated on the operating system level under Control Panel and Power Options.

7.2.2 Installing the ACS450

Prior to installing the ACS450, all applications that are not really required must be shut down.

The Setup_DE.exe file can be called up directly for the installation.

Starting the setup program

To start the setup program, insert the CD contained in the software package into the CD-ROM drive and proceed as follows:

Windows: If the installation program does not start, select Execute from the Windows start menu. Then, type `d:\Setup_EN.exe` (replace `d` by the letter of the CD-ROM drive) and click Ok.

Then, the installation program will give the required instructions.

If an earlier version of the ACS450 has already been installed, this version must be deinstalled first.
1.1.1. Deinstalling

- Select Windows Start and then the Settings dialog
- Select the Apps uninstall dialog
- Select the ACS450 and deinstall the program by clicking the Uninstall button
In the dialog that appears it is possible to select whether the existing installation should be removed.

Note!
In the case of a deinstallation, only the program files will be removed, not the files in the Data directory.

7.2.3 Disposal

The following notes on disposal do not apply worldwide. The user must ensure that the relevant local disposal regulations are complied with. The CD itself is made of polycarbonate and should be recycled together with the enclosure. The CD’s envelope is made of PS 06 and must be disposed of as special waste.
7.3 Files included in the scope of delivery

The files on the program CD are provided in a condensed form. During installation, these files will be unzipped and filed in the selected directory on the target drive.

The following files will be copied:

- ACS450.EXE
- ACS450REGISTRATION.EXE
- LMV_ABE.DLL
- DIALOG.COD
- PAR_NAME.COD
- PARA_NR_0170.COD
- PARA_NR_0220.COD
- PARA_NR_0250.COD
- PARA_NR_0350.COD
- PARA_NR_0360.COD
- PARA_NR_0370.COD
- PARA_NR_0380.COD
- PARA_NR_0390.COD
- PARA_NR_0400.COD
- PARA_NR_0410.COD
- PARA_NR_0420.COD
- PARA_NR_0430.COD
- PARA_NR_0440.COD
- PARA_NR_0450.COD
- PARA_NR_0460.COD
- PARA_NR_0470.COD
- PARA_NR_0480.COD
- PARA_NR_0490.COD
- PARA_NR_0500.COD
- PARA_NR_0510.COD
- PARA_NR_0520.COD
- PCTOOL_STAT.COD
- LMV_STATUS.COD
- MANUAL_D.PDF
- MANUAL_E.PDF
- TOOLDOKU_AB_D.INI
- TOOLDOKU_HF_D.INI
- TOOLDOKU_OEM_D.INI
- TOOLDOKU_AB_E.INI
- TOOLDOKU_HF_E.INI
- TOOLDOKU_OEM_E.INI
In addition – during installation – the following files for the database administration will be filed in the Windows system directory:

- MSVCRT.DLL
- MSFLXGRD.OCX
- MFC42.DLL
- MSLTUS35.DLL
- MSECXL35.DLL
- MTEXT35.DLL
- MSPDOX35.DLL
- MSXBSE35.DLL
- MSREPL35.DLL
- EXPSRV.DLL
- VBAR332.DLL
- VBAJET32.DLL
- MSJINT35.DLL
- MSJTER35.DLL
- MSRD2X35.DLL
- MSJET35.DLL
- DAO350.DLL
- DAO2535.TLB

### 7.4 Generated files

When making a connection to the LMV5 system, the ACS450 generates a data directory on a level below the program directory.

The following files will be saved in the directory:

- Database files (*.mdb) for the parameter settings
- Database files (*.tdb) for trending data
- Parameter files (*.par) for parameter sets
8 General note!

The visual appearance of the relevant screen content is influenced by the settings of the Windows operating system. In Windows 10, for example, the relevant settings can be found under Settings / Themes.

Setup screenshots in this documentation have been created using the Windows design setting.
9 Installation of ACS450

To start installing the ACS450, select the Setup_EN.exe file from the directory selected by you for installing the files of the ACS450. Double-click on the Setup_EN.exe file to start the installation.

Follow the Installation Instructions
Click on Next >
Read the EULA carefully. The agreement must be accepted before continuing with the installation. If you reject the agreement, the installation is canceled.

Click on Next >.

You can enter your company and user name here.

Click on Next >.
The setup will install the ACS450 in the suggested folder.

Click on **Browse...** to select a different folder.

Click on **Next >** to continue.

Click on **Install** to continue.

The ACS450 is installed.
To start the ACS450, click on **Finish**.
10 The first steps
10.1 Program registration

To be able to permanently work with the program, it must be correctly registered. If this is not done, only the functions of the Enduser (AB) level will be available.

![Register Program](image)

Enter the **License Number** given on the ASN label (rear of CD envelope) in the entry field.

When clicking the **Register** button, the registration message will appear.

![Registration successful](image)

Then click on **OK**.

Upon registration, you can make full use of the program.
10.2 Operation of the ACS450 in connection with the LMV5 system

**Warning**
Before connecting the ACS450 to an LMV5 system, the safety warnings given in chapter *Typographical conventions* must be strictly observed.

Before connecting the ACS450 to an LMV5 system, it must be ensured that the parameters set on the LMV5 have been protected by individual burner identification. This can be checked with the AZL5 on the *Operation → Burner Identification* menu. If required, burner identification can be entered via the OEM level. For that purpose, use the menu of the AZL5 *Update → Burner Identification*.

**Note!**
The individual burner identification is automatically proposed as the file name for the database file. The existing menu and parameter structure is stored in this database file.

Only individual burner identification ensures unambiguous assignment of the parameter backup on the AZL5 to the associated LMV5 system components. This makes certain that inadmissible or unintentional parameter set transmissions between different boiler plants will be prevented.

When burner identification is ensured, proceed as follows:
- Connect the PC to the COM 1 port of the AZL5 via the serial connection
- Set the AZL5 for use with the ACS450 via *Operation → Optg Mode Select → Interface PC*
- Start the ACS450 program by double clicking on the link symbol on the desktop
- Read the *Safety Warnings* dialog carefully and confirm by clicking Ok
- After starting the ACS450 program, there is no connection yet to the LMV5 system via the AZL5. In this mode, previous recordings can be viewed via the file dialog
- Establish the connection via the ACS450 by using the menu bar of the ACS450. Select *System LMV5x → Connect*

![Fig. 4: Connection](image)
- Select the access level and enter the password in the Password dialog box. Then, confirm by clicking Ok.

Note!
The Enduser level requires no password.

When, after entering the password, a connection has been established, the program reads the system’s burner identification. Then, a search is made to find out if there is a database with the name of that burner identification. If that is not the case, the menu and parameter structure of the AZL5 will be read in and filed in the database. Then, the Parameters menu will automatically be generated on the System LMV5x menu of the menu bar.

- Select the required function via the Parameters menu. Here, the menu structure corresponds to that of the connected AZL5.

## 10.3 Closing the program

The online mode can be closed via System LMV5x → Disconnect.

To close the ACS450, select the File Close menu.

Note!
If Disconnect is not executed before Close, the ACS450 will automatically close the connection.

## 10.4 ACS450 in offline mode

Here, data that were previously uploaded online can be displayed or printed out with no need for having a connection to the plant.

For that purpose, open the database file in which the parameters were saved via the File menu and select Show Parameters. If successful, the read functions are available as if a connection to the plant existed.

Reference!
For more details, refer to chapter Offline mode.
11  General operating functions
11.1  Scope of functions

Basically, the scope of functions of the ACS450 corresponds to those of the AZL5 of the LMV5 system.

The major extended operating and display choices provided by a PC-supported tool are the following:
- Graphic support when setting the electronic fuel/air ratio control system
- Trend recording (write function)
- Print functions for documenting the plant settings
- Backup/Restore via PC

The following functions are not provided by the PC tool and must be performed directly on the AZL5:
- TÜV test
- Starting adaption
- Resetting the basic unit
- Selecting the operating mode of the AZL5
- Setting the display contrast of the AZL5
- Addressing the actuators
- Deleting the curves (fuel/air ratio control system)
- Updating the passwords

11.2  Title bar

After opening a connection, or in offline mode, the title bar shows the name of the opened database next to the program name. That name corresponds to the burner identification of the LMV5 system.

11.3  Operating mode
11.3.1  Operation of the ACS450 on the plant
11.3.1.1  Overview

Connect the PC to the serial COM 1 port of the AZL5 using a connecting cable. When the connection is opened, the ACS450 checks whether this is the first time operation is started or whether it is a repeated process. For that purpose, it is checked whether a valid file with the required system information already exists in the data directory of the ACS450.

11.3.1.2  First-time operation

When opening a connection to the plant for the first time, the program reads information for generating the menu and parameter definitions and stores these data in a database.

A process bar shows the current process.

11.3.1.3  Repeated operation

When connecting the ACS450 to the plant and starting the program, the burner identification of the LMV5 system is compared with the data in the database to determine whether this LMV5 system has already been connected. If that is the case and the parameter settings of the file correspond to those in the LMV5 system, time-consuming reading in is no longer required and – after an integrity check with the help of a CRC comparison – the PC will adopt that database.
11.4 Password

11.4.1 Overview

The passwords are assigned to the Service (HF) and OEM access levels, which mean that the parameters that can be changed are only those associated with the respective access level.

The Enduser (AB) level does not have a password protection since no safety-related parameter settings can be made on that level.

Note!
The ACS450 does not save its own passwords. This means that the password to be entered for the associated level corresponds to that of the LMV5 system.

11.4.2 Entering the password

When entering the password, a distinction must be made between uppercase and lowercase letters. After entering, confirm by clicking Ok or deactivate the password entry by clicking Close.

If no password is entered, the Enduser (AB) level is active.

The password time set is 30 minutes.
The password expires if there are no user activities via the keyboard or the mouse for 30 minutes.
When the password time has expired, the following dialog will appear. The user can reenter the password.

Fig. 6: Valid time has elapsed
11.4.3 Changing and leaving the password level

The password can be changed via Parameters → Password Login. Using the next menu item Password Logout, it is possible to return to the Enduser (AB) level.

Fig. 7: Changing the password
11.5 Normal operation

In this dialog box, general information about the operating state of the LMV5 system is given. The user cannot make any entries.

![Normal Operation Dialog Box]

**Updating**

The data are updated at 3-second intervals. To check an active connection between ACS450 and AZL5, there is an indicator light PC ↔ AZL in the upper right hand corner. It flashes when data are transmitted.

**Display and symbols**

The fuel-dependent ranges are active or inactive, depending on the selected type of fuel. Activated inputs and outputs appear in green.
11.6 Fault status

The status of the LMV5 system can be queried via View → Fault Status.

![Fig. 9: Calling up the fault status](image)

What appears here is a dialog with cleartext on the plant status of the LMV5 system and other important data that are used for pinpointing faults.

![Fig. 10: Fault status](image)

**Note!**

The dialog can be concluded by clicking Close. However, if the fault has not yet been rectified, the dialog will immediately reappear. If you want to perform further actions in spite of the fault status, the dialog must not be closed but dragged to an area of the screen that is not required for these actions.
11.7 Parameter settings and configuration

Warning!
Observe the safety warnings given in chapter Typographical conventions!

11.7.1 Introduction

With the ACS450, parameters can be changed the way they are with the AZL5. When selecting a parameter dialog, it is always the current value of the AZL5 that is read in. Parameters must always be changed with the Slider or the «+» and «-» buttons. In the case of a parameter with predefined text, it is also possible to select a value via the list box.

The program reads the permissible minimum and maximum limit values as well as the increments from the AZL5.

Settings can only be made within the permissible limit values using the available increments. This procedure is aimed at preventing false operations.

To document the parameter set, it is also possible to store all parameters in a database.

11.7.2 Procedure

Between PC and AZL5, the procedure is the following:
- Change one or several parameters in the Input column
- For that purpose, select a field in the Input column
- In accordance with Windows standards, the field appears with a blue background and the value appears in white

![Fig. 11: Selecting a parameter](image-url)
Changing the parameter

The parameter can be changed any time by moving the Slider with the mouse (use the left mouse button) or by clicking the «+» or «-» button above and below the slider.

The changed but not yet stored field will appear with a yellow background.

Changing several parameters

It is possible to change several parameters in an opened dialog and to click Write only then.

Transferring the changes to the LMV5 system

After clicking Write, the changed parameters will be filed in the LMV5 system.
Checking storing  

After delivering the parameters, the PC software will automatically read back the data from the AZL5. If successful, the ACS450 ensures that the entry field will appear with a green background. Then, a dialog will prompt you to check all displayed values again. This is made by a visual comparison of the Value on AZL with the Input. The relevant values will be shown with a green background, indicating the values to be verified.

Note!  
This visual check is mandatory!

![Fig. 13: Verifying the parameter change](image)

Fault during the storing procedure  

If the transmission has not been successful, the Input field will appear with a red background and the value on the AZL5 also. The ACS450 checks if a fault occurred during storage or during the subsequent reading back of the value and if, after successful storage and reading back, both values are identical. If a fault occurs, a dialog also tells you about it.

Reference!  
Observe the notes given in chapter Fault handling!

Example:  
The LMV5 system is in the operating position. It is not permitted to set the parameters of Fan Run-up Time. The system cannot make these parameter settings.

![Fig. 14: Fault during the parameter setting procedure](image)
When making a change to the *Input* column and clicking *Close*, the following dialog appears:

![Dialog box](image.png)

Fig. 15: Message appearing during the parameter setting procedure

When selecting **Yes**, you will go back to the last setting dialog and the changed fields in the *Input* range are still active. When selecting **No**, the settings of the last dialog will be discarded.
11.8 Backup/restoring the data sets

11.8.1 Backup the AZL5

Fig. 16: Backup the AZL5

The ACS450 induces the AZL5 to store the current parameter settings of the LMV5 system in the nonvolatile backup memory (EEPROM) of the AZL5. In addition, the following information is filed in the same memory. It is required for assigning the data set at a later point in time:

- Time of storage of the backup (time of day/date)
- LMV5 units contained in the backup

When the storing process starts, the Ok button is deactivated until the process is terminated, to prevent intervention by the user.
11.8.2 Restore

The ACS450 induces the AZL5 to store back the parameter set of the LMV5 system contained in its nonvolatile memory (EEPROM) that was previously triggered by a backup process directly on the AZL5 or by the ACS450.

Note!
All parameter changes that were previously made can be overwritten by a Restore process, provided the changes were not previously saved by a Backup process in the AZL5.

Note!
When the storing process starts, the Ok button is deactivated until the process is terminated, to prevent intervention by the user.

During the restore process, the Fault Status dialog will automatically be shown. That dialog appears every time the Close button is selected. For this reason, we recommend to move the dialog aside so that the restore dialog underneath remains visible and editable.

11.8.3 Backup/Restore via PC

These functions require an AZL5 version 3.40 or higher.

Fig. 17: System LMV5 Restore/Backup
11.8.3.1 Backup

Backup can be retrieved via System LMV5x → Backup LMV → PC. When calling up the function, the AZL5 will automatically be requested to update its parameter set. When this is being done, the status field displays Input File Name (*.par) and the Save in File button becomes active. Individual information about the parameter set can be entered in the text field for comments. This information is then saved in the file together with the parameters to be displayed again later for restoring. After selecting this button, the file dialog will appear. When the file name is confirmed, the saving process is started. The result will appear in the status field.
11.8.3.2 Restore

Backup can be retrieved via System LMV5x → Restore PC → LMV. After selecting the file (*.par) via the file dialog, the restore dialog will appear.

![Restore PC → LMV](image)

First, the burner identification of the file and that of the basic unit are compared with one another. The result will be shown in the status field and, if both are identical, the Store in LMV button will be activated. Before starting the process with this button, in AZL Backup Memory can be used to select whether the parameter set shall also be stored in nonvolatile memory (EEPROM) of the AZI5. In that case, the status field shows the current state of the restore process. The restore function is only available when there is a connection. If a parameter set shall be stored in a basic unit without having a valid burner identification, function Initialize the basic unit is required. This function is described below.
11.9 Resetting/initializing the basic unit

These functions require an AZL5 of version V03.40 or higher. If no valid AZL5 is connected, the menu item will stay deactivated.

11.9.1 Resetting the basic unit

Resetting can be retrieved via System LMV5x → Reset BU. Function Reset the basic unit resets the burner identification and the fuel trains. This may be required if, when replacing a basic unit, it becomes evident that the fault was not caused by the basic unit itself. In that case, the basic unit can be reset to a state that allows the restore process to be made without burner identification. When calling up, the password dialog appears first, since this function is only available from the Service level.

When selecting the Reset button, the process is irrevocably started. Then, the connection must be cut.
11.9.2 Initializing the basic unit

Resetting can be retrieved via System LMV5x → Initialize BU. In principle, function Initialize BU performs the same process as Restore PC → LMV, the difference being that no valid burner identification is required here. Hence, operation is analogous to the above function.

11.10 Switch-off function (manual locking of the basic unit LMV5)

![Warning]
Observe note given in chapter Fault handling!

Manual locking can be retrieved via menu System LMV5x → Lockout.

This function can be performed only if the connection to the LMV5 system is activated. If lockout is successful, the LMV5 system will deliver fault status Manual Lockout AZL to the ACS450. In that case, the following dialog will appear:

![Fig. 22: Manual lockout]

**Note!**
Due to the intrinsic delay of the system, the time required from manual lockout to lockout of the basic unit LMV5 is about 2 seconds, and another 10 seconds maximum for the dialog to appear. A reset with the ACS450 cannot be made.

Lockout on the AZL5 is also possible in interface mode by simultaneously pressing the Enter and Esc buttons.
11.11 Adjusting the fuel/air ratio control system

**Warning**
Observe the note given in chapter *Fault handling*!

### 11.11.1 Modulating operation

#### 11.11.1.1 Overview

This menu item contains the subitem *Curve Display* and *Curve Setup* for firing on gas or oil.

Entering the curve points

Enter the curve points graphically with the mouse or with the arrow keys. The arrow keys are used in particular for making the fine adjustments. The display of the curve is updated while the settings are made. For each type of fuel, a maximum of 6 curves each with 15 curve points is provided. The curve points and the other data required (e.g. special positions) are read by the AZL5 when selecting the function. When curve points become available, they will be graphically displayed and connected by straight lines.

In addition, when starting the adjustment of the fuel/air ratio control system, the following system data will be displayed:

- Current operating phase
- Current load
- Current O2 value
- Fault status

**Note!**
The operating element and the curve points for the actuators and the variable speed drive appear only when activated.

![Curve dialog](image)

Fig. 23: Curve dialog
Note!
The Load box shows the current load as all actuators are driven to their respective positions. In addition, when selecting an existing curve point, the load assigned to the positions is displayed here. The assignment of load can also be changed via this box (refer to Changing the load assignment of a curve point). Entry box Manual Load serves for predefining the required load the system shall approach.

When selecting the Curve Dialog menu, all curve points available at that time will be shown as a curve. If no curve points exist at the time the menu is opened, the graph will be shown without any curves. In the case of subsequent startup and an activated curve dialog, the first point of the curve storage of the LMV5 basic unit will automatically be displayed when the operating phase is reached.

Note!
This point is automatically generated by the basic unit and corresponds to the ignition positions.

The parameter setting mode of the LMV5 basic unit for setting curve parameters becomes active only when the first parameter settings in the curve dialog are made:
  - Adjust the manual load (by moving the slider, entry via the keyboard or the spinner associated with the text field) and then click Go to or Confirm
  - Delete a curve point

Fig. 24: Setting elements for the manual load
The settings can be made in the following phases:

- Lockout (phase number 0)
- Standby (phase number 12)
- Operation (phase number 60)
11.11.1.2 Defining a new curve point position

For that purpose, the predefined load is required at which a new curve point shall be established. Set the slider for the manual load (pink triangle) to the new load.

This is made in one of the following ways:

- Select the slider with the mouse and shift it while keeping the left mouse button depressed
- Click the arrow buttons next to Manual Load
- Press the arrow keys of the PC keyboard after selecting the slider with the mouse or after selecting the manual load

Then, click Go to.

When the predefined load is reached, the Set Point button will become active and can be clicked. This is possible between curve points that already exist, and below and above the curves that have already been parameterized. In that case, extrapolated straight lines are used that represent extensions of the last curve points.

From now on, until Store or Discard is clicked, no action can be performed, apart from changing the actuator positions at this curve point, e.g. the Cancel Point action is not possible.

Next, select the actuator whose current position shall be changed. This is made via the selection in the options field.

![Selection of actuator](image)

Fig. 26: Selection of actuator
To change the actuator position, set the mouse pointer to the current position and shift the marking while keeping the left mouse button depressed. Release the button and the curve will be redrawn. To newly change a position that has already been shifted, set the mouse pointer to the square symbol and then change as described above.

**Fine adjustment**

A fine adjustment can be made with the arrow buttons of the respective actuator in the dialog window.

After changing the position, click Go to. This causes the actuators to travel to the preselected positions.

**Changing the load assignment of a curve point**

Like the actuator positions, the load assignment of a curve point can be changed. This has an impact on the slope of the curves. The load assignment can be changed by shifting the currently handled curve point (blue background) or by clicking the associated arrow buttons (top right). The load assignment can only be changed within two neighboring curve points.

**Storing/discarding the new point**

To store the curve point in the LMV5 system as a new curve point with its associated curve point, click the Store button.

When selecting Discard, the curve point in the ACS450 can be deleted. In that case, there is no storage in the LMV5 system and the actuators will automatically return to the positions they had assumed before the positions were changed.

11.11.1.3 Changing an existing curve point

To change an existing curve point, proceed as follows:
- Set the mouse cursor to the markers of an existing curve point (grey triangles)
- Confirm by clicking Go to

When reaching the load corresponding to the curve point, all following actions can be performed as described in subsection Defining a new curve point position.

When clicking Discard, the curve point with its values is retained in the LMV5 system.

11.11.1.4 Changing an existing curve point without Go to

To change an existing curve point, proceed as follows:
- Set the mouse cursor to the markers of an existing curve point (grey triangles).
- Set the marker to without Go to
- Confirm by clicking Confirm

When reaching the load corresponding to the curve point, all following actions can be performed as described in subsection Defining a new curve point position.

It is to be noted here, however, that Go to will be replaced by Confirm and, for the curve point to be changed, the system need not (!) operate at the output of that curve point.
11.11.1.5 Deleting a curve point

To delete a curve point, proceed as follows:

- Click **Delete**.
- Click on the curve point to be deleted (grey rider). The point will then be deleted.
- The dialog can now be closed or the curve points changed, new ones added, or existing curve points deleted.
- To delete another point, click **Delete** again first.

11.11.1.6 Quitting the curve dialog

To terminate the setting of the curve, click **Close**.

**Note!**
If setting of the curve parameters is quit without storing the curve points (clicking the **Discard** button), the curve points last entered will be lost.

11.11.1.7 Stop function

The **STOP** button stops any action that was started by clicking **Go to**. This means that the system will continue to deliver its current output or, in other words, it will maintain its current positions.

11.11.1.8 Tabular display of the curve points

When clicking **Table** in the curve dialog, the curve points will numerically appear in a table.

The table can be viewed at any time, but it cannot be edited.

![Fig. 27: Display of the curve points in tabular form](image)
11.11.9 Printing

When clicking Print, the print dialog of Windows appears. After selecting the required printer, the setting of the system will graphically appear.

To permit unambiguous identification, the printout will contain the following data:
- Burner identification
- Type of fuel
- Date/time of printout
11.11.2 Multistage operation

11.11.2.1 Overview

When entering the fuel/air ratio control system, the current data of the system will be constantly displayed:
The actuator positions, the current load, the current phase and the fault status.
Also, the switching points used are displayed in tabular form.

Note!
The operating elements for the output of stage 3 appear only when operating mode three-stage is selected. Also, the elements for the auxiliary actuator and the variable speed drive are displayed only when the actuator is activated.

![Fig. 28: Dialog for multistage fuel/air ratio control](image)

11.11.2.2 Changing a point

To change a point, proceed as follows:

- Select the point via the option field in the dialog, e.g. Stage 1 Operating Point
- Change the parameter with the arrow buttons
- The following choices are available:
  - Go to: The actuator is driven to the predefined position and the associated fuel valve will be activated or deactivated
  - Store: The new position will be stored in the LMV5 system
  - Discard: The new value will not be adopted by the LMV5 system

Note!
When storing, the color patterns used are the same as those used when changing parameters.

Reference!
Refer to section Faults during the parameter setting procedure.

In the event of fault, refer to the notes given in section Faults during the parameter setting procedure.

11.11.2.3 Printing

When clicking Print, the current values will be printed out in tabular form.
11.12 O2 setting

**Warning**
Observe the note given in chapter Fault handling!

When setting the O2 values, the min values must be parameterized first whereupon the fuel/air ratio values can be set.
When calling up the setup, a check is first made to see if min. 3 curve points are available. As with the fuel/air ratio setting, available curve points are represented by graphic symbols (little triangles).

11.12.1 Setting the O2 min values

Fig. 29: Making the O2 setting

11.12.1.1 Direct entry of values

With the direct entry, a curve point is first selected by clicking on the symbol. Then, the O2 Min Value option must be activated. Use the arrow buttons to set the O2 value. The value will be stored by selecting the Storing O2 Min Value button.

11.12.1.2 Setting by reducing the air rate

To do this, proceed as follows:
- Select the curve point by clicking on the symbol
- Select the P Air manual option
- Confirm by selecting the Go to button

After reaching the curve point, use the arrow buttons and then select Go to to reduce the amount of combustion air. The act. O2 Value field shows the current O2 value. When the required min value is reached, select the Storing O2 Min Value button to store the current value.
11.12.2 Setting the O2 ratio values

Note!
Before defining the O2 ratio values, all O2 min values must be set. If the ratio curves are changed later, the O2 ratio values must also be readjusted.

For each curve point, proceed as follows:
- Select the curve point and click on the symbol
- Confirm the curve point by selecting the Go to button
- When the current O2 value has stabilized, store it as a ratio value
- Use the arrow buttons to set the standardized value and select the Go to button
- When the setpoint is reached, store it

With the second and last curve point, the basic unit makes an automatic adaption and displays the result. When the setting of every curve point is completed, the values will be entered in the chart. Neighboring points are then connected by lines. In addition, the lambda factor will automatically be calculated and displayed.

11.12.3 Leaving the O2 setting

The O2 setting is concluded by selecting the Close button. If not all of the available curve points are set, a note will appear.

11.12.4 Tabular display

By selecting the Table button, the current values of the O2 setting will be displayed in tabular form. The values cannot be changed.
11.12.5 Printing

When selecting the Print button, the Windows standard printer dialog appears. After selection of the required printer, the setting of the O2 values will be given in graphic format.

In addition, for identification purposes, the following data are printed out:
- Burner identification
- Type of fuel
- Date and time of day of output

11.13 Fault history and lockout history

11.13.1 Fault history

The fault history can be called up via Parameters → Operating State → Fault History.

The fault history is delivered in the form of a table.

The structure of the fault history corresponds to that of the AZL5.

With every fault entry, the following information is delivered:
- Fault code, diagnostic code, fault class
- Phase of the LMV5 system, active type of fuel, load and start counter reading at the time the fault occurred
- Clear-text on the cause of fault

All entries stored in the AZL5 (up to 21) can be viewed in the dialog. When selecting the Print button, the current values will be printed out in tabular form.

11.13.2 Lockout history

The lockout history can be called up via Parameters → Operating State → Lockout History.

The lockout history is delivered in the form of a table.

The structure of the lockout history corresponds to that of the AZL5.

With every lockout code, the following information is delivered:
- Fault code, diagnostic code, fault class
- Phase of the LMV5 system, date and time of day, active type of fuel, load, start counter reading and number of operating hours at the time lockout occurred
- Clear-text on the cause of lockout

All entries stored in the AZL5 (up to 9) can be viewed in the dialog. When selecting the Print button, the current values will be printed out in tabular form.

11.14 Time of day and date

A dialog that permits viewing of date, time of day and weekday of the real time clock of the LMV5 system can be called up via Operation → Date/Time of Day → Set Clock. This dialog contains a button Synchronizing the Clock, which performs the transfer of the system time from the PC to the LMV5 system.
11.15 Trending/write function
11.15.1 Overview

Here, an X-Y recorder is simulated that displays key system data. If required, these data can be stored in a database to be displayed later for diagnostic purposes, or for printing out.

11.15.2 Calling up the trending function

When retrieving the trending function, a database needs to be specified first where the data shall be filed. It is possible to select an existing database by choosing the file name and by clicking Open for writing. In the database, the program reserves an entry for the new measurement. The name will be assigned later in the main dialog. Alternatively, a new database can be generated. The file name will be entered in the File Name field. The file name extension used is tdb. Then, the entry is to be confirmed by clicking Open.

After selecting an existing or defining a new database, the trending window will appear.
11.15.3 The trending window

The trending window consists of a data window that is used for the graphic display of the values over time:

X-axis: Time axis
Y-axis: Indication of value; the associated unit depends on the channel settings; the associated legend is to the right of the data window. The name of a channel appears when the mouse pointer is moved to the indicated value.

![Trending window](image)

Fig. 31: The trending window

When calling up the trending function, the current status of the selected channels will immediately appear, but there is no storage in the database yet. That takes place only after starting a recording, either by clicking Start, or in the case of a trigger condition, if activated. Recording is terminated either by clicking Stop or in the case of a trigger condition.

11.15.4 Display of a channel

A channel can be activated or deactivated with the associated check box. The color can be selected with a dialog, which appears in the legend after clicking the relevant button.

To make the display clearer (making better use of the y-axis), a multiplier/divisor for the individual channels can be specified. This has an impact on the division ratio of the input variable and the displayed variable on the graph.

Example:
The temperature value of 500 °C will be displayed as 50 °C when making the following settings:
- Multiplier = 1
- Divisor = 10
11.15.5  *Display settings*

In offline mode, the relevant buttons allow the display settings for the X- and Y-coordinates to be changed. For more detailed information.

Reference!
Refer to subsection *Settings in Display*.

11.15.6  *Printing*

In offline mode, the Print button allows the graph to be output on the printer based on the settings made before in *Display*.

Reference!
For more detailed information, refer to subsection *Settings in Display*.

11.15.7  *Setting the interval*

The interval for reading in the measurements can be set in increments between 1 and 20 seconds.
11.15.8 Triggering

The trigger conditions can be selected with a dialog, which appears after clicking the ... button.

![Trigger Settings dialog](image)

The following trigger conditions can be selected:
- **Start Trigger**: Definition of the required channel and of the associated value at which the trigger condition is satisfied
- **Stop Trigger**: Here, it is also possible to define the channel and the associated value

**Note!**
The set start and stop trigger conditions will then be displayed in the main dialog under **Trigger**.

The following settings can be made under **Times**:
- **Pretrigger Time**: Here, it is possible to enter the period of time for which data shall be filed in the database before the start trigger condition is satisfied
- **Posttrigger Time**: Here, it is possible to define the period of time for which data shall be filed in the database after the stop trigger condition is satisfied

The set trigger conditions and the status can be viewed in the main dialog on trending.

The settings for triggering become active only when clicking **Trigger active**.

11.15.9 Status display

The **Status** display provides information about the trigger status and the free storage for the database.

It is thus possible to find out if there are sufficient system resources available for the database, especially in the case of short recording intervals.
11.15.10 Full screen

The **Full Screen** button shows the trending window as a full picture until the **Esc** button is pressed.

11.15.11 Name of measurement

In the database, the recording is filed under a certain name. That name can be predefined, either automatically or manually. The dialog will appear after clicking the **...** button.

Automatic name assignment is selected as standard. Here, the name selected by the program is *New Measurement XXX*, whereby XXX stands for a consecutive number.

![Fig. 33: Name of measurement](image)

**Note!**
Automatic name assignment must be selected if several trigger events are to be expected, thus ensuring automatic recording of several measurements in the database. If, in that case, automatic name assignment is deactivated, the recording will be terminated when the first condition for *Stop Trigger* is met.
11.16  Program update AZL5

11.16.1  Introduction

The program update is used for updating the program in the AZL5. This process writes a new binary file with the name extension *bin* into the memory of the AZL5. The major functions of the AZL5 are defined in that memory. In addition, the AZL5 has a memory in its microcontroller. That memory is a non-erasable read only memory and is used primarily for loading the update. The backup memory in the AZL5, which is used for the parameters (EEPROM), will not be affected by the updating process. To do the program update, connect the AZL5 to the LMV5 system and the PC. The LMV5 system must be ready to operate.

11.16.2  Preparing the AZL5

Software loading must be prepared on the AZL5. To do this, select *Updating* from the menu and *Confirm*.

After selecting the access level (permitted from the service level), select menu item *Load SW from PC* and *Confirm*.

The AZL5 displays:

*Load SW from PC – Start Process with Enter – Cancel with Esc.*

Press Enter to prepare the AZL5 for the process.

Then, the AZL5 will display the following message (example):

SW Update - MC:V01.00:V01.00 - FLASH:V01.70 - cancel: Left key.

Here, you see the software versions of the microcontroller (MC) contained in the AZL5, as well as the program memory (flash) prior to updating. If in doubt, the updating process can be aborted.

Note!
The structure of the MC’s software version is the following:
The first number up to the colon gives directly the software version of the microcontroller used. The second number after the colon is used for making the internal version check and must be identical to the first number.

11.16.3  Preparing the ACS450

On the ACS450, proceed as follows:
Select *System LMV5x → Update AZL Flash* to make a file dialog appear.
Select the file that contains the flash data, thus starting the programming process.

11.16.4  Programming process

Just prior to starting the programming process, the following messages will appear on the display of the AZL5:

*clearing flash, then programming*

The ACS450 and AZL5 now show the progress with the current status.
11.16.5 End of the programming process - check

When the programming process is completed, the ACS450 will display the message Transfer completed.
When successfully programmed, the ACS450 will display SW Update OK and the updated SW version.

Example:
MC: V01.00: V01.00 - Flash: V01.80 - cancel: Left key

In the event of fault, the AZL5 will display the following message: error occurred

In that case, the cause of the fault is to be investigated. For example, one of the connectors of the serial line between AZL5 and PC may be lose. Rectify the fault and start programming again.
When pressing the left button on the AZL5, System Test will appear. Then, the AZL5 will operate with the new software.
12 Offline mode

12.1 Overview

In offline mode, parameter settings and trending data (write function) that were previously recorded on an LMV5 system can be viewed and printed out, even without having a connection to the system. It is not possible to make changes or to store back to the system at a later time.

12.2 Preparation for the display of parameters

Using System LMV5x → Backup Data Base, the user can store the current parameter settings (*.mdb) on the PC’s hard disk. 

Backup Database
12.3  Calling up the parameter display

This option is active only when no connection to the plant exists.

Using a file dialog, you can select a database (standard directory: ..\data) into which the setting values of a given plant were previously loaded.

Reference!
Refer to section Preparation for the display of parameters.

Access level

After opening the file, use another dialog to define the access level you require for displaying the data.
The only parameters that will be displayed are those assigned to the relevant access level.
The assignment corresponds to the operation of the ACS450 on the LMV5 system.

Note!
The access level can be selected without a password since writing is not possible.

Select File → Show Parameters.
12.4 Control file for displaying and printing parameters

To print parameters, they must be stored in a database first. These data can be shown and printed out later in offline mode. This requires a control file. That file specifies the parameters that will be output and the way they are formatted. It is thus possible to make individual printouts relating to the documentation. Explanatory comments can be entered throughout the control file. These are identified by a semicolon at the beginning of the line. Main section and print sections are identified by brackets «[ ]».

The name of the control file is predefined and depends on the password level:

- Enduser level (AB) tooldoku_AB.ini
- Service level (HF) tooldoku_HF.ini
- OEM level tooldoku_OEM.ini

Sample file

A sample file is filed in the program directory. This displays all available parameters of the relevant password level. This sample file can be used as a template for creating your specific control file.

12.4.1 Main section of file

The main section of the file carries the name [Parameter].

The following key words are available:

Version = xx.yy This information is mandatory. It gives the software version of the AZL5 for which the control file is valid.

Test = 1 If this value is given, the control file will be newly read in each time the print preview is shown. This is useful when creating the control file. It is thus possible to check the file before everything is printed out. Apart from that, to speed up the display, this entry should not exist.

Section = <Name> The name to be selected is the print section.

Example:

[Parameter]
Version = 1.70
Test = 1
Section01 = Title
Section02 = Param_Gas_Oil
Section03 = Title
Section04 = Param_Gas
Section05 = Title
Section06 = Param-Oil
12.4.2 Print section

Specify in the print section now how a parameter is output at a certain position on the print page. In addition, you can format the output by defining the font and different graphic objects. Some key words require the definition of coordinates and lengths. The reference point for the coordinates is the top left hand corner. All lengths are given in mm.

The following key words are available:

- **VariableX** = Output of a parameter
  - Parameter: X-coordinate, Y-coordinate
  - Alignment: left-aligned = 0, middle = 1, right-aligned = 2
  - Size in mm
  - Parameter number

- **LinieX** = Draws a line
  - Parameter: starting point (X-coordinate, Y-coordinate), end point (X-coordinate, Y-coordinate)

- **RectangleX** = Draws a rectangle
  - Parameter: X-coordinate, Y-coordinate, width, height

- **FontX** = Sets font type
  - Parameter: bold On/off = 0/1, italics On/off = 0/1, underlined On/off = 0/1, reserved always 0, font name

- **TextX** = Delivers a fixed text with the selected font type
  - Parameter: X-coordinate, Y-coordinate
  - Alignment: left-aligned = 0, middle = 1, right-aligned = 2
  - Size in mm
  - Text

- **DateX** = Output of the current (computer) date
  - Parameter: X-coordinate, Y-coordinate
  - Alignment: left-aligned = 0, middle = 1, right-aligned = 2
  - Size in mm

- **GraphX** = Output of a graph
  - Parameter: X-coordinate, Y-coordinate, width, height
  - Name of the graph:
    - TabStufOel: Table multistage operation
    - TabModOel: Table modulating operation oil
    - TabModGas: Table modulating operation gas
    - GrafModOel: Graph modulating operation oil
    - GrafModGas: Graph modulating operation gas
    - O2
PageX = Trigger page feed

Parameter: 1\textsuperscript{st} value: not used
2\textsuperscript{nd} value: Y-coordinate with screen display
3\textsuperscript{rd} and 4\textsuperscript{th} value: not used

Example:

[Title]
Date0 = 170; 10; 2; 5;
Rectangle0 = 10; 10; 180; 30;
Text0 = 90; 25; 1; 10; parameter LMV5x

[Parameter_Gas]
Page1 = 0; 300; 0; 0;
Font1 = 0; 0; 1; 0; Arial
Text1 = 10; 40; 0; 5; parameter gas
Font 12 = 0; 0; 0; 0; Arial
Text12 = 10; 50; 0; 5; graph of fuel/air ratio control system
Graph11 = 10; 50; 100; 130; GrafModGas;
Text13 = 10; 150; 0; 5; prepurge time gas;
Variable13 = 90; 150; 2; 5; GG_Time_TprepurgeGas
12.5 Trending/show write function

12.5.1 Overview

In offline mode, the user can view and print trending data (*.tdb) previously stored on the PC’s hard disk.

12.5.2 Selecting the database

This option is active only when no connection to the plant exists. Using a file dialog, the user can select a database file (standard directory: \data), where the data of a certain plant were previously stored.

Reference! (refer to chapter Offline mode).

In another dialog, you can select the required measurement from that file and confirm the selection by clicking Ok.

Fig. 36: Displaying trending

In another dialog, you can select the required measurement:

Fig. 37: Selecting a measurement
Using the export function of the Measurement dialog, the contents of the database can also be downloaded to a new file in Excel format *.csv (segregated by a semicolon) in order to make a selective measurement.

By clicking Delete, you can remove a previously selected measurement from the database.

12.5.3 Main dialog Trending

After selecting the database and the measurement, the main dialog of trending will be displayed.

12.5.3.1 Settings in Display

Here, you can make the basic settings for the X- and Y-coordinates by clicking the respective buttons. Several choices and zoom functions are available so that optimum displays can be achieved.

12.5.3.2 Trending diagram/write function

For that purpose, call up the trending dialog first. Then, carry out the steps described in online mode.

- **Reference!**
- Refer to subsection Fault handling.

By clicking Print, the diagram with the settings previously defined in Display will be output on the printer.
13 Online help

The ACS450 has an electronic help file (online help). The Operating Instructions on the ACS450 are displayed by pressing the F1 key or via the Help menu. The CD-ROM contains these Operating Instructions as a PDF file.

To display the Operating Instructions, Acrobat Reader of version 4.x or higher must be installed on the PC. If Acrobat Reader is not available, the program can be downloaded from the internet for installation on the PC.

14 Fault handling

14.1 Faults during the parameter setting procedure

If a fault occurs during the parameter setting procedure, make the following checks:

- Check if the parameters can be set in the current phase of the LMV5 system.

  Example:
  The prepurge time cannot be changed during the Startup sequence. Should the fault occur there, select a suitable phase of the basic unit LMV5 (e.g. lockout, standby) and repeat the process.

- In the event of a transmission error due to a problem in the connecting line between ACS450 and AZL5 (e.g. due to a lose connector), correct the cause of the fault and carry out a new upload from the LMV5 system by Close and Open the current parameter dialog. Then, check the parameter settings. If necessary, set the parameters again.

Note!

If the parameters cannot be successfully set via the ACS450, repeat the parameter setting procedure directly on the AZL5. It should then be checked whether all associated components function correctly.

14.2 Faults when opening a connection

If a connection to the LMV5 system cannot be opened via the PC tool, make the following checks:

- Check if the line between PC tool and AZL5 is connected to the correct ports. The port to be used on the PC is the port that was specified for the installation procedure. On the AZL5, the port to be used is that under the front cover.

- Check whether the cable used meets the specification.

Reference!
Refer to section Installing the hardware.
List of figures

Fig. 1: Connection diagram............................................................................................ 15
Fig. 2: Connecting cable ............................................................................................ 15
Fig. 3: Registration......................................................................................................... 27
Fig. 4: Connection.......................................................................................................... 28
Fig. 5: Password ............................................................................................................ 29
Fig. 6: Valid time has elapsed ........................................................................................ 31
Fig. 7: Changing the password ...................................................................................... 32
Fig. 8: Normal operation .............................................................................................. 33
Fig. 9: Calling up the fault status ................................................................................... 34
Fig. 10: Fault status ....................................................................................................... 34
Fig. 11: Selecting a parameter ....................................................................................... 35
Fig. 12: Changing a parameter ........................................................................................ 36
Fig. 13: Verifying the parameter change ........................................................................ 37
Fig. 14: Fault during the parameter setting procedure ................................................... 37
Fig. 15: Message appearing during the parameter setting procedure ......................... 38
Fig. 16: Backup the AZL5 .............................................................................................. 39
Fig. 17: System LMV5 Restore/Backup ........................................................................ 40
Fig. 18: Backup LMV5 ↔ PC ....................................................................................... 41
Fig. 19: Restore PC → LMV ........................................................................................ 42
Fig. 20: Resetting/initializing the basic unit .................................................................... 43
Fig. 21: Resetting the basic unit .................................................................................... 43
Fig. 22: Manual lockout ............................................................................................... 44
Fig. 23: Curve dialog .................................................................................................. 45
Fig. 24: Setting elements for the manual load ................................................................ 46
Fig. 25: Setting elements for the manual load (without Go to) ....................................... 47
Fig. 26: Selection of actuator ....................................................................................... 48
Fig. 27: Display of the curve points in tabular form .................................................... 50
Fig. 28: Dialog for multistage fuel/air ratio control ..................................................... 52
Fig. 29: Making the O2 setting ..................................................................................... 53
Fig. 30: Setting the O2 values ..................................................................................... 54
Fig. 31: The trending window ..................................................................................... 57
Fig. 32: Trigger Settings dialog ................................................................................... 59
Fig. 33: Name of measurement .................................................................................. 60
Fig. 34: Access level for offline mode ........................................................................... 64
Fig. 35: Showing parameters in offline mode ............................................................... 64
Fig. 36: Displaying trending ....................................................................................... 68
Fig. 37: Selecting a measurement ................................................................................ 68
Index

A
aborting the parameter change .................................................. 38
access level .................................................................................. 64
ACS450 in offline mode ................................................................. 29
adjusting the fuel/air ratio control system .................................. 45
automatic assignment of name .................................................... 60
B
backup ....................................................................................... 41
backup database ........................................................................... 63
backup info .................................................................................. 39
backup the AZL5 .......................................................................... 39
backup/restore via PC .................................................................... 40
backup/restoring the data sets ..................................................... 39
C
calling up the parameter display ................................................... 64
calling up the trending function .................................................. 56
changing a point ........................................................................... 52
changing an existing curve point .................................................. 49
changing an existing curve point without Go to ......................... 49
changing and leaving the password level .................................... 32
changing several parameters ...................................................... 36
changing the actuator positions at a curve point ......................... 48
changing the load assignment of a curve point ......................... 49
changing the parameter .............................................................. 36
changing the parameters and the plant configuration ..................... 9
checking storing ......................................................................... 37
closing the program .................................................................... 29
connecting cable ......................................................................... 17
display file for displaying and printing parameters ...................... 65
correct system parameter settings ............................................... 9
correct usage .............................................................................. 8
D
defining the new curve point position .......................................... 48
deinstalling/repairing .................................................................. 18
delete ........................................................................................... 69
deleting a curve point .................................................................. 50
direct entry of values .................................................................. 53
display and symbols .................................................................... 33
display of a channel .................................................................... 57
display settings ........................................................................... 58
disposal ........................................................................................ 18
E
de end of the programming process - check .................................. 62
END USER LICENSE AGREEMENT .............................................. 11
entering the curve points ............................................................. 45
entering the password .................................................................. 31
export .......................................................................................... 69
F
fault during the storing procedure .............................................. 37
fault handling .............................................................................. 70
fault history .................................................................................. 55
fault history and lockout history ................................................. 55
fault status ................................................................................... 34
faults during the parameter setting procedure ......................... 70
faults when opening a connection ............................................... 70
files included in the scope of delivery ........................................... 19
down adjustment ........................................................................ 49
first-time operation ..................................................................... 30
full screen ................................................................................... 60
G
General note ................................................................................. 21
general operating functions ....................................................... 30
generated files ............................................................................ 20
H
handling and storages ............................................................... 16
I
individual burner identification .................................................. 28
initializing the basic unit ............................................................. 44
installation .................................................................................. 17
Installation of ACS450 ................................................................. 22
installing the ACS450 ................................................................. 18
installing the hardware ............................................................... 17
installing the software ............................................................... 18
introduction ................................................................................ 35
L
languages ................................................................................... 16
leaving the O2 setting .................................................................. 54
lockout history ............................................................................ 55
M
main dialog trending ................................................................. 69
main section of file ....................................................................... 65
modulating operation .................................................................. 45
multistage operation ................................................................... 52
N
name of measurement .................................................................. 60
normal operation ......................................................................... 33
notes on handling the CD ............................................................ 16
O
O2 setting ..................................................................................... 53
offline mode ............................................................................... 63
online help .................................................................................. 70
operating mode .......................................................................... 30
operation of the ACS450 in connection with the LMV5 .................. 28
operation of the ACS450 on the plan .......................................... 30
Overview ..................................................................................... 30
P
parameter settings and configuration ........................................... 35
password ..................................................................................... 31
preparation for the display of parameters .................................... 63
preparing the ACS450 ................................................................. 61
preparing the AZL5 ................................................................. 61
print section ................................................................................ 66
printing ...................................................................................... 51, 52, 55, 58
<table>
<thead>
<tr>
<th>Procedure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>procedure</td>
<td>35</td>
</tr>
<tr>
<td>program registration</td>
<td>27</td>
</tr>
<tr>
<td>program update AZL5</td>
<td>61</td>
</tr>
<tr>
<td>programming process</td>
<td>61</td>
</tr>
<tr>
<td>qualified staff</td>
<td>8</td>
</tr>
<tr>
<td>quitting the curve dialog</td>
<td>50</td>
</tr>
<tr>
<td>repeating operation</td>
<td>30</td>
</tr>
<tr>
<td>resetting the basic unit</td>
<td>43</td>
</tr>
<tr>
<td>resetting/initializing the basic unit</td>
<td>43</td>
</tr>
<tr>
<td>restore</td>
<td>40, 42</td>
</tr>
<tr>
<td>safety guidelines</td>
<td>8</td>
</tr>
<tr>
<td>scope of delivery</td>
<td>7</td>
</tr>
<tr>
<td>scope of functions</td>
<td>30</td>
</tr>
<tr>
<td>screwed locks for the connectors</td>
<td>17</td>
</tr>
<tr>
<td>selecting the database</td>
<td>68</td>
</tr>
<tr>
<td>setting by reducing the air rate</td>
<td>53</td>
</tr>
<tr>
<td>setting the electronic fuel/air ratio control system</td>
<td>9</td>
</tr>
<tr>
<td>setting the interval</td>
<td>58</td>
</tr>
<tr>
<td>setting the O₂ min values</td>
<td>53</td>
</tr>
<tr>
<td>setting the O₂ ratio values</td>
<td>54</td>
</tr>
<tr>
<td>settings in display</td>
<td>69</td>
</tr>
<tr>
<td>settings under Windows</td>
<td>18</td>
</tr>
<tr>
<td>shutdown function of the LMV5 basic unit via the ACS450</td>
<td>10</td>
</tr>
<tr>
<td>starting the setup program</td>
<td>18</td>
</tr>
<tr>
<td>status display</td>
<td>59</td>
</tr>
<tr>
<td>stop function</td>
<td>50</td>
</tr>
<tr>
<td>storing/discard the new point</td>
<td>49</td>
</tr>
<tr>
<td>switch-off function</td>
<td>44</td>
</tr>
<tr>
<td>system specification</td>
<td>15</td>
</tr>
<tr>
<td>tabular display</td>
<td>54</td>
</tr>
<tr>
<td>tabular display of the curve points</td>
<td>50</td>
</tr>
<tr>
<td>the first steps</td>
<td>27</td>
</tr>
<tr>
<td>the trending window</td>
<td>57</td>
</tr>
<tr>
<td>time of day and date</td>
<td>55</td>
</tr>
<tr>
<td>title bar</td>
<td>30</td>
</tr>
<tr>
<td>transferring the changes to the LMV5</td>
<td>36</td>
</tr>
<tr>
<td>trending diagram/write function</td>
<td>69</td>
</tr>
<tr>
<td>trending/show write function</td>
<td>68</td>
</tr>
<tr>
<td>trending/write function</td>
<td>56</td>
</tr>
<tr>
<td>triggering</td>
<td>59</td>
</tr>
<tr>
<td>typographical conventions</td>
<td>8</td>
</tr>
<tr>
<td>updating</td>
<td>33</td>
</tr>
</tbody>
</table>